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Abstract 

The Landfill Gas Emissions Model (LandGEM) is an automated estimation tool with a 
Microsoft Excel interface that can be used to estimate emission rates for total landfill gas, 
methane, carbon dioxide, nonmethane organic compounds, and individual air pollutants 
from municipal solid waste landfills. This guide provides step-by-step guidance for using 
this software application, as well as an appendix containing background information on the 
technical basis of LandGEM. LandGEM can use either site-specific data to estimate 
emissions or default parameters if no site-specific data are available. The model contains 
two sets of default parameters, CAA defaults and inventory defaults. The CAA defaults are 
based on federal regulations for MSW landfills laid out by the Clean Air Act (CAA) and can 
be used for determining whether a landfill is subject to the control requirements of these 
regulations. The inventory defaults are based on emission factors in EPA’s Compilation of 
Air Pollutant Emission Factors (AP-42) and can be used to generate emission estimates for 
use in emission inventories and air permits in the absence of site-specific test data. 
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Foreword


The U.S. Environmental Protection Agency (EPA) is charged by Congress with protecting 
the Nation’s land, air, and water resources. Under a mandate of national environmental laws, 
the Agency strives to formulate and implement actions leading to a compatible balance 
between human activities and the ability of natural systems to support and nurture life. To meet 
this mandate, EPA’s research program is providing data and technical support for solving 
environmental problems today and building a science knowledge base necessary to manage 
our ecological resources wisely, understand how pollutants affect our health, and prevent or 
reduce environmental risks in the future. 

The National Risk Management Research Laboratory (NRMRL) is the Agency’s center for 
investigation of technological and management approaches for preventing and reducing risks 
from pollution that threaten human health and the environment. The focus of the Laboratory’s 
research program is on methods and their cost-effectiveness for prevention and control of 
pollution to air, land, water, and subsurface resources; protection of water quality in public 
water systems; remediation of contaminated sites, sediments and ground water; prevention 
and control of indoor air pollution; and restoration of ecosystems.  NRMRL collaborates with 
both public and private sector partners to foster technologies that reduce the cost of 
compliance and to anticipate emerging problems. NRMRL’s research provides solutions to 
environmental problems by: developing and promoting technologies that protect and improve 
the environment; advancing scientific and engineering information to support regulatory and 
policy decisions; and providing the technical support and information transfer to ensure 
implementation of environmental regulations and strategies at the national, state, and 
community levels. 

This publication has been produced as part of the Laboratory’s strategic long-term research 
plan. It is published and made available by EPA’s Office of Research and Development to 
assist the user community and to link researchers with their clients. 

Sally Gutierrez, Acting Director 
National Risk Management Research Laboratory 
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EPA Review Notice


This report has been peer and administratively reviewed by the U.S. Environmental 
Protection Agency and approved for publication. Mention of trade names or commercial 
products does not constitute endorsement or recommendation for use. 

This document is available to the public through the National Technical Information 
Service, Springfield, Virginia 22161. 
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Introduction 

This document provides step-by-step guidance for using the Landfill Gas Emissions Model 
(LandGEM), a software application with a Microsoft Excel interface that estimates air 
pollutants and other gases from municipal solid waste (MSW) landfills. Using this 
document, you will learn how to 

• Enter landfill-specific data, 
• Choose between site-specific and default model parameters, 
• Estimate emission rates, and 
• View and print tabular and graphical results. 

Overview of How LandGEM Works 

LandGEM is an automated tool for estimating emission rates for total landfill gas, methane, 
carbon dioxide, nonmethane organic compounds (NMOCs), and individual air pollutants 
from MSW landfills. Landfill owners and operators can use LandGEM to determine if a 
landfill is subject to the control requirements of the federal New Source Performance 
Standards (NSPS) for new MSW landfills (40 CFR 60 Subpart WWW), the federal Emission 
Guidelines (EG) for existing MSW landfills (40 CFR Subpart Cc), or the National Emission 
Standards for Hazardous Air Pollutants (NESHAP) for MSW landfills (40 CFR Subpart 
AAAA). 

LandGEM can use either site-specific data to estimate emissions or default parameters if no 
site-specific data are available. LandGEM contains two sets of default parameters. 

CAA Defaults—The CAA defaults are based on requirements for MSW landfills 
laid out by the Clean Air Act (CAA), including the NSPS/EG and NESHAP. This set 
of default parameters yields conservative emission estimates and can be used for 
determining whether a landfill is subject to the control requirements of the NSPS/EG 
or NESHAP. 

Inventory Defaults—With the exception of wet landfill defaults, the inventory


defaults are based on emission factors in the U.S. Environmental Protection
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Agency’s (EPA’s) Compilation of Air Pollutant Emission Factors (AP-42). This set 
of defaults yields average emissions and can be used to generate emission estimates 
for use in emission inventories and air permits in the absence of site-specific test 
data. 

The default parameters in Version 3.02 of LandGEM represent values specified by 
NSPS/EG and NESHAP for determining applicability of CAA requirements. Also included 
are values specified in AP-42 for developing national and state emission inventories. The 
AP-42 values are being updated with new information that has been collected by EPA from 
more recent field tests. In addition, research is underway to obtain data for developing 
emission factors for wet/bioreactor landfills where leachate and other liquids are added to 
accelerate waste decomposition. 
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Section 1.

Understanding LandGEM


LandGEM is based on a first-order decomposition rate equation for quantifying emissions 
from the decomposition of landfilled waste in MSW landfills. The software provides a 
relatively simple approach to estimating landfill gas emissions. Model defaults are based on 
empirical data from U.S. landfills. Field test data can also be used in place of model defaults 
when available. Further guidance on EPA test methods, CAA regulations, and other 
guidance regarding landfill gas emissions and control technology requirements can be found 
at http://www.epa.gov/ttnatw01/landfill/landflpg.html. 

LandGEM is considered a screening tool—the better the input data, the better the estimates. 
Often, there are limitations with the available data regarding waste quantity and 
composition, variation in design and operating practices over time, and changes occurring 
over time that impact the emissions potential. Changes to landfill operation, such as 
operating under wet conditions through leachate recirculation or other liquid additions, will 
result in generating more gas at a faster rate. Defaults for estimating emissions for this type 
of operation are being developed to include in LandGEM along with defaults for 
conventional landfills (no leachate or liquid additions) for developing emission inventories 
and determining CAA applicability. Refer to the Web site identified above for future 
updates to LandGEM. 

Appendix A provides further background information regarding the technical basis of 
LandGEM and how it relates to landfill emissions, methane, carbon dioxide, NMOCs, and 
air pollutants. 

1.1 Spreadsheet Design 
LandGEM consists of nine worksheets within a Microsoft Excel spreadsheet. The worksheet 
names and their functions are listed in Table 1. 
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Worksheet Name	 Function 

INTRO	

USER INPUTS	

POLLUTANTS	

INPUT REVIEW	

METHANE	

RESULTS	

GRAPHS	

INVENTORY	

REPORT	

Contains an overview of the model and important notes about 
using LandGEM 

Allows users to provide landfill characteristics, determine 
model parameters, select up to four gases or pollutants (total 
landfill gas, methane, carbon dioxide, NMOCs, and 46 air 
pollutants), and enter waste acceptance rates 

Allows users to edit air pollutant concentrations and molecular 
weights for existing pollutants and add up to 10 new pollutants 

Allows users to review and print model inputs 

Calculates methane emission estimates using the first-order 
decomposition rate equation 

Shows tabular emission estimates for up to four gases/ 
pollutants (selected in the USER INPUTS worksheet) in 
megagrams per year, cubic meters per year, and user’s choice 
of a third unit of measure (average cubic feet per minute, cubic 
feet per year, or short tons per year) 

Shows graphical emission estimates for up to four gases/ 
pollutants (selected in the USER INPUTS worksheet) in 
megagrams per year, cubic meters per year, and user’s choice 
of a third unit of measure (selected in the RESULTS 
worksheet) 

Displays tabular emission estimates for all gases/pollutants for 
a single year specified by users 

Allows users to review and print model inputs and outputs in a 
summary report 

Table 1. Worksheet Names and Functions in LandGEM 

1.2 First-Order Decomposition Rate Equation 
LandGEM uses the following first-order decomposition rate equation to estimate annual 
emissions over a time period that you specify. The model parameters k and Lo used by this 
decomposition equation are described further in Section 3.0. 
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where 
QCH4 = annual methane generation in the year of the calculation (m3/year) 
i = 1 year time increment 
n = (year of the calculation) - (initial year of waste acceptance) 
j = 0.1 year time increment 
k = methane generation rate (year-1) 
Lo = potential methane generation capacity (m3/Mg) 
Mi = mass of waste accepted in the ith year (Mg) 
tij = age of the jth section of waste mass Mi accepted in the ith year (decimal years, e.g., 

3.2 years) 

1.3 Software Requirements 
LandGEM requires Microsoft Excel 97 or a more recent version of Excel. Earlier versions 
of Excel are unable to properly run the model because macros are embedded in the software. 

Enable Macros—You must select Enable Macros when prompted (immediately 
after opening the file) to allow the LandGEM software to use macros embedded in 
the file. LandGEM has been carefully screened and is free of any viruses. 

Macro Security—If you are using Microsoft Excel 2000 or Excel 2002 (within the 
Microsoft Office XP software package), you must set your Macro Security Level to 
Medium prior to opening the software to allow the Enable Macros option to be 
selected. If your Macro Security Level is set to High when the model is opened, then 
the warning message shown in Image 1 will appear, and the embedded macros 
needed to run LandGEM properly will be disabled. You can adjust the Macro 
Security Level in Excel by selecting Macro...Security from the Tools menu and 
clicking on the Medium radio button. Although LandGEM can operate with the 
Macro Security Level set to Low, this setting is not recommended by Microsoft. 

Image 1. Macro Security Warning Message. 
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Memory Requirements—You should have a minimum of 64 megabytes of random 
access memory (RAM). In addition, you will need a minimum of 2 megabytes of free 
space on your hard drive to accommodate the LandGEM software. 

Read Only Feature—LandGEM has been specified as a Read Only file. You save a 
copy of LandGEM under a new file name when running each landfill scenario. The 
Read Only restriction is intended to protect the original file from being inadvertently 
over-written. If necessary, you can remove this restriction by changing the file 
properties via a file management program (e.g., Windows Explorer). 

Password Protection Feature—To avoid user modifications from occurring within 
the model, all of the worksheets contained in LandGEM and the Microsoft Excel 
workbook itself have been password protected. 

Screen Resolution—The optimum screen resolution for viewing LandGEM is 1024 
by 768 pixels. To change the screen resolution, you can open the Control Panel from 
the Start menu, open the Display folder, select the Settings tab at the top of the 
window, and adjust the Screen resolution or Screen area option (depending on your 
version of Windows) accordingly. 

1.4 Significant Differences Between Model Versions 
LandGEM Version 3.02 replaces Versions 2.01 and 3.01. Significant differences between 
Versions 2.01 and 3.02 of LandGEM include: 

•	 Version 3.02 uses a revised first-order decomposition rate equation that improves the 
accuracy of emission estimates over time, especially for landfills being modeled 
using higher methane generation rate (k) values. The equation used in Version 2.01 
integrates emissions over each year, whereas the revised equation in Version 3.02 
integrates emissions over a 0.1 year time increment. This revision is considered an 
improvement over the previous calculation methodology. This new equation in 
Version 3.02 results in slightly lower emission estimates than previous versions for 
typical k values. For example, Version 3.02 emission estimates are 2% lower for a k 
of 0.05 year-1 (CAA Conventional) and 1% lower for a k of 0.02 year-1 (CAA Arid 
Area). Version 3.02 estimates significantly lower emissions for higher k values—for 
example, 25% lower for a k of 0.7 year-1 (Inventory Wet). 
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•	 Version 3.02 allows users to model emissions of total landfill gas, which can be 
calibrated using a user-specified methane content other than 50 percent. In Version 
2.01, users cannot estimate total landfill gas emissions directly and must calculate 
total landfill gas off-line using methane emission estimates. 

•	 Version 2.01 uses metric units of measure exclusively, whereas Version 3.02 allows 
users to choose between several English (e.g., short tons, cubic feet) and metric (e.g., 
megagrams, cubic meters) units of measure for model inputs and outputs. 

•	 Version 2.01 reports emissions for 200 years past closure year of the landfill,

whereas Version 3.02 reports emissions for 140 years total.


•	 Version 2.01 does not allow waste to be accepted in the closure year. To provide 
users with more flexibility when entering inputs, Version 3.02 was changed to allow 
waste to be accepted in the closure year. 

•	 Version 2.01 contains AP-42 default values and air pollutant concentrations and 
molecular weights that were current as of September 1997 (Supplement C of the 5th 

Edition). Version 3.02 contains revised AP-42 default values (within the inventory 
defaults), air pollutant concentrations, and molecular weights that are current as of 
November 1998 (Supplement E of the 5th Edition). 

•	 Version 3.02 incorporates inventory default k and Lo values for wet landfills (such as 
bioreactors). 

•	 Version 3.02 replaces Version 3.01 by correcting an error when av ft3/min or ft3/year 
is selected as the user-specified unit in the RESULTS worksheet. 

1.5 Differences Between the Model and AP-42 
Significant differences between Version 3.02 of LandGEM and EPA’s Compilation of Air 
Pollutant Emission Factors (AP-42) include: 

•	 The inventory default values for NMOC concentration and several air pollutant 
concentrations used in Version 3.02 of LandGEM differ slightly from those in the 
November 1998 version (Supplement E of the 5th Edition) of AP-42. These minor 
differences are due to rounding of the concentration values to more accurately reflect 
their relative uncertainty. These rounding differences are expected to be rectified in 
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an upcoming revision of AP-42 for MSW landfills because the uncertainty of the 
values within the current version of AP-42 do not accurately correspond with the 
inherent uncertainty of the NMOC and air pollutant concentrations. 

•	 Due to a revision in the first-order decomposition rate equation used in Version 3.02 
of LandGEM (Section 1.4), the methane generation equation (Equation 1) within 
AP-42 no longer matches the equation used by LandGEM. Differences between the 
two calculation methodologies are expected to be rectified in an upcoming revision 
of AP-42 for MSW landfills. 
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Section 2.

Providing Landfill Characteristics


Enter data on the USER INPUTS worksheet that relate to the identity and size of the landfill 
being modeled. 

• Landfill name or identifier, 
• Landfill open year, 
• Landfill closure year, 
• Option to have model calculate closure year, and 
• Waste design capacity. 

Image 2 shows these inputs as they appear on the USER INPUTS worksheet. To clear all of 
the landfill characteristic inputs, gas/pollutant selections (see Section 4.0), and waste 
acceptance rate data (see Section 5.0), click on Clear ALL Non-Parameter Inputs/Selections 
in the USER INPUTS worksheet. These inputs will then return to their defaults. 

Image 2. Landfill Characteristics Inputs. 

2.1 Landfill Name or Identifier 
Use the Landfill Name or Identifier to enter a landfill’s name and scenario information (for 
example, “Landfill A - Closed Cells” or “Landfill A - Leachate Recirculation Cells”). You 
can also enter information about the landfill as it relates to the types of model parameters 
chosen (for example, “Landfill B - NSPS/EG Conventional k Value” or “Landfill B - User-
specified k = 0.06”). Model parameters are discussed further in Section 3.0. The Landfill 
Name or Identifier entry box is limited to 50 characters. 
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The Landfill Name or Identifier you enter on the USER INPUTS worksheet is shown in the 
same location on other worksheets within LandGEM. You are not required to enter 
information into the Landfill Name or Identifier entry box. The Landfill Name or Identifier 
entry box is not affected by the Clear ALL Non-Parameter Inputs/Selections button. 

2.2 Landfill Open Year 
Landfill Open Year is a required input and represents the year that the landfill began 
accepting waste. The open year should be in a four-digit year format (e.g., 2004). 

2.3 Landfill Closure Year 
Landfill Closure Year represents either of the following in LandGEM: 

• Final year the landfill accepted waste, or 
• Year the landfill is expected to reach Waste Design Capacity. 

LandGEM uses the closure year of the landfill to determine the final year the landfill has 
accepted or is planning to accept waste. The “permitted” closure year of the landfill does not 
always represent the same year the landfill ceases to accept waste. 

Landfill Closure Year is not a required input. However, if Landfill Closure Year is unknown, 
then you must select Yes for the Have Model Calculate Closure Year? option, AND you 
must enter Waste Design Capacity. If you enter a closure year, but still select Yes for the 
option to have the model calculate closure year, then the model will disregard the closure 
year you entered and automatically calculate closure year for you. 

The model limits the number of years for entering Waste Acceptance Rates to 80 years (see 
Section 5.0 for further discussion about Waste Acceptance Rates). If the Landfill Closure 
Year entered is greater than 80 years from the Landfill Open Year entered (i.e., over 80 years 
of waste acceptance), then the model will disregard the Landfill Closure Year entered and 
will assign the 80th year past the Landfill Open Year as the final year of waste acceptance (or 
the closure year) used by the model to estimate emissions. For example, if you enter a 
Landfill Open Year of 1940, a Landfill Closure Year of 2030, and Waste Acceptance Rates 
for 1940-2004, then the model will only allow Waste Acceptance Rates to be entered for 
2005 to 2019 and will calculate emissions as though the landfill closed in 2019. See Section 
2.6 for instructions on estimating total emissions properly for scenarios where landfills 
accept waste beyond the waste acceptance limit of 80 years. 
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2.4 Have Model Calculate Closure Year? 
If Landfill Closure Year is unknown, select Yes for the option to have the model calculate 
closure year. The default option is No. You must enter the Waste Design Capacity if you 
want the model to calculate closure year for you. Waste Design Capacity is discussed further 
in Section 2.5. 

If you allow LandGEM to determine the closure year, it does so based on Landfill Open 
Year, Waste Design Capacity, and Waste Acceptance Rates you entered. Essentially, 
LandGEM calculates the closure year by summing the Waste Acceptance Rates entered, 
subtracting this “waste-in-place” amount from the Waste Design Capacity entered, and then 
dividing by the final (or most recent) acceptance rate entered. The model assumes that your 
final waste acceptance rate entered will continue to be the annual amount of waste accepted 
until closure of the landfill or until there are 80 years of waste acceptance, whichever 
scenario comes first (see Section 5.0 for further discussion about Waste Acceptance Rates). 

Example 1 illustrates how the model calculates the closure year if it is unknown. 

Example 1. Scenario for Unknown Landfill Closure Year 

Landfill open year = 1970 
Landfill closure year = ? 
Have model calculate closure year? = Yes 
Waste design capacity = 5,000,000 short tons 
Waste acceptance rate from 1970 to 1990 = 100,000 short tons/year 
Waste acceptance rate from 1991 to 2000 = 200,000 short tons/year 

⎡ (Waste design capacity − ∑ (Waste acceptance rates ))  ⎤
Calculated landfill closure year = 

⎣⎢ Final waste acceptance rate in 2000 ⎦⎥ 

+ Year of final waste acceptance rate 

⎡ 5 000 000 short tons − , , tons ) ⎤( ,  ,  4 100 000 short 
Calculated landfill closure year = 

200 000 short tons ⎦⎥ 
+ 2000 

⎣⎢ , 

= 2005 

The model limits the number of years for entering Waste Acceptance Rates to 80 years (see 
Section 5.0 for further discussion about Waste Acceptance Rates). If the Waste Design 
Capacity has not been reached by the 80th year of waste acceptance, then the model will 
assign the 80th year past the Landfill Open Year entered as the final year of waste acceptance 
(or the closure year) used by the model to estimate emissions. For example, if you allow the 
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model to calculate closure year and enter a Landfill Open Year of 1960, a Waste Design 
Capacity of 10,000,000 Mg, and Waste Acceptance Rates of 100,000 Mg/year for 
1960S2004, then the model will calculate emissions as though the landfill closed in 2039 
because that is when it will reach the 80-year limit of waste acceptance. See Section 2.6 for 
instructions on estimating total emissions properly for scenarios where landfills accept waste 
beyond the waste acceptance limit of 80 years. 

2.5 Waste Design Capacity 
Waste Design Capacity represents the total amount of waste that can be disposed of in the 
landfill, or the amount of “waste-in-place” upon closure. Enter Waste Design Capacity only 
when you select Yes for the Have Model Calculate Closure Year? option. If you enter Waste 
Design Capacity without selecting Yes, the model will simply disregard the capacity amount 
you entered. 

Waste Design Capacity can be entered in metric units of megagrams or English units of 
short tons. (Note: One megagram is equivalent to one metric ton.) Select the units of 
measure using the drop-down menu. The default unit of measure for Waste Design Capacity 
is megagrams. 

Landfill gas emission factors were developed using empirical data from U.S. MSW landfills. 
The composition of waste in the landfills reflects U.S. waste composition including MSW, 
inert material, and other non-hazardous waste streams. If a portion of the landfill contains 
primarily non-biodegradable waste (i.e., inert material), such as ash from waste combustion, 
this portion may be subtracted from the Waste Design Capacity, depending upon 
documentation and approval from a regulatory authority. However, this is not recommended 
for sites that are typical of MSW landfills, which contain a range of waste that may or may 
not be degradable. This is because the emission factors were developed relating total waste 
quantity to total quantity of landfill gas. 

2.6 Landfills Accepting Waste Over 80 Years 
Sections 2.3 and 2.4 explain scenarios where LandGEM will implement a waste acceptance 
limit of 80 years in order to estimate emissions properly. If you are modeling a landfill that 
either has accepted or will accept waste for over 80 years, then multiple model runs are 
required to calculate emissions for the entire waste acceptance lifetime of the landfill. You 
should associate a unique file name and Landfill Name or Identifier in the USER INPUTS 
worksheet for each model run to properly identify the order of the model runs (“Landfill X ­
Run 1 of 2” and “Landfill X - Run 2 of 2,” for example). 
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When the 80-year waste acceptance limit is exceeded, the INPUT REVIEW worksheet 
reports the actual landfill closure year that would be reached in absence of the 80-year limit. 
The additional years of waste acceptance can be modeled in a successive model run in order 
to capture the total emissions from the actual waste acceptance lifetime. The METHANE 
worksheet provides the waste-in-place amount at the end of the initial 80 years and 
remaining waste capacity from the final year of the initial model run if you have chosen to 
have model calculate closure year. These values can be used as inputs for the second model 
run. Once both model runs have been completed, then the emissions on the RESULTS 
worksheet from each run can be summed together by year for each gas/pollutant to result in 
total emissions for the actual waste acceptance lifetime of the landfill. 

Example 2 outlines a scenario for running LandGEM multiple times in order to accurately 
represent the emissions for landfills accepting waste over 80 years. 
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Example 2. Scenario for Landfills Accepting Waste Over 80 Years 

First Model Run Inputs on USER INPUTS Worksheet:

Landfill open year = 1940

Landfill closure year = ?

Have model calculate closure year? = Yes

Waste design capacity = 12,000,000 Mg

Waste acceptance rate from 1940 to 2000 = 100,000 Mg/year

Waste acceptance rate from 2001 to 2004 = 200,000 Mg/year


First Model Run Results on METHANE Worksheet:

Closure year (with 80-year limit) = 2019

Actual closure year (without limit) = 2030

Calculated waste acceptance rate from 2005 to 2019 = 200,000 Mg/year

Waste-in-place at start of next model run = 9,900,000 Mg

Capacity remaining at start of next model run = 2,100,000 Mg


Second Model Run Inputs on USER INPUTS Worksheet:

Landfill open year = 2020 [One year past closure year from the first model run]

Landfill closure year = ?

Have model calculate closure year? = Yes

Waste design capacity = 2,100,000 Mg [Capacity remaining from the first model run]

Waste acceptance rate for 2020 = 200,000 Mg/year [Calculated waste acceptance rate from the

first model run]


Second Model Run Results on METHANE Worksheet:

Closure year (with 80-year limit) = Actual closure year (without limit) = 2030

Total annual emissions for each gas/pollutant = (Run 1 emissions) + (Run 2 emissions)

For example, methane emissions for 2021 = 2.586×107 + 1.662×106 = 2.752×107
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Section 3.

Determining Model Parameters


LandGEM relies on several model parameters to estimate landfill emissions. 
• Methane generation rate (k), 
• Potential methane generation capacity (Lo), 
• NMOC concentration, and 
• Methane content. 

Default values for the model parameter inputs on the USER INPUTS worksheet are shown 
in Image 3. Model parameters should be selected using consistent default options. For 
example, if “Inventory Conventional - 0.04” is chosen for k, then “Inventory Conventional ­
100” should be selected for Lo and “Inventory No or Unknown Co-disposal - 600” or 
“Inventory Co-disposal - 2,400” should be selected for NMOC Concentration. When using 
LandGEM to determine whether a landfill is subject to the control requirements of the 
NSPS/EG or NESHAP, CAA defaults must be chosen for all four model parameters. 

Image 3. Model Parameters Inputs. 

You may select each of the model parameters from the drop-down menu. Alternatively, you 
may enter site-specific model parameter values other than the default values based on field 
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data or other information. Select User-specified for the model parameter for which you 
would like to enter site-specific data. A User-specified value entry box will appear to the 
right of that parameter and you can  enter the site-specific value. User-specified value entry 
boxes only appear when User-specified is selected from the drop-down menu for a particular 
model parameter. 

Clicking on Restore Default Model Parameters in the USER INPUTS worksheet resets all 
four of the model parameters back to their default values (shown in Image 3) and removes 
any user-specified values entered. 

3.1 Methane Generation Rate (k) 
The Methane Generation Rate, k, determines the rate of methane generation for the mass of 
waste in the landfill. The higher the value of k, the faster the methane generation rate 
increases and then decays over time. The value of k is primarily a function of four factors: 

•	 Moisture content of the waste mass, 
•	 Availability of the nutrients for microorganisms that break down the waste to form 

methane and carbon dioxide, 
•	 pH of the waste mass, and 
•	 Temperature of the waste mass. 

Use EPA Method 2E to determine site-specific k values for user-specified data. The k value, 
as it is used in the first-order decomposition rate equation, is in units of 1/year, or year-1. The 
five k values used by LandGEM are shown in Table 2. Arid area landfills are located in 
areas that receive less than 25 inches of rainfall per year. The default k value is the CAA k 
value for conventional landfills. 

Table 2. Values for the Methane Generation Rate (k). 

Default Type Landfill Type k Value 
year-1 

CAA Conventional 0.05 (default) 

CAA Arid Area 0.02 

Inventory Conventional 0.04 

Inventory Arid Area 0.02 

Inventory Wet (Bioreactor) 0.7 
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3.2 Potential Methane Generation Capacity (Lo) 
The Potential Methane Generation Capacity, Lo, depends only on the type and composition 
of waste placed in the landfill. The higher the cellulose content of the waste, the higher the 
value of Lo. The default Lo values used by LandGEM are representative of MSW. The Lo 

value, as it is used in the first-order decomposition rate equation, is measured in metric units 
of cubic meters per megagram to be consistent with the CAA. The five Lo values used by 
LandGEM are shown in Table 3. The default Lo value is the CAA Lo value for conventional 
landfills. 

Table 3. Values for the Potential Methane Generation Capacity (Lo). 

Emission Type Landfill Type Lo Value 
m3/Mg 

CAA Conventional 170 (default) 

CAA Arid Area 170 

Inventory Conventional 100 

Inventory Arid Area 100 

Inventory Wet (Bioreactor) 96 

3.3 Nonmethane Organic Compound Concentration 
The NMOC Concentration in landfill gas is a function of the types of waste in the landfill 
and the extent of the reactions that produce various compounds from the anaerobic 
decomposition of waste. NMOC Concentration is measured in units of parts per million by 
volume (ppmv) and is used by LandGEM only when NMOC emissions are being estimated. 
The NMOC Concentration for the CAA default is 4,000 ppmv as hexane. The NMOC 
Concentration for the inventory default is 600 ppmv where co-disposal of hazardous waste 
has either not occurred or is unknown and 2,400 ppmv where co-disposal of hazardous 
waste has occurred. 

The default NMOC Concentration is the CAA value. If you use a site-specific value for 
NMOC concentration, then you must correct for air infiltration. EPA Method 25C is 
recommended for obtaining a site-specific concentration of NMOCs. 

3.4 Methane Content 
For LandGEM, landfill gas is assumed to be 50 percent methane and 50 percent carbon 
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dioxide, with additional, trace constituents of NMOCs and other air pollutants. When using 
LandGEM for complying with the CAA, Methane Content must remain fixed at 50 percent 
by volume (the model default value). 

You may choose other methane amounts for the Methane Content using the User-specified 
selection if data exist to support using another concentration. However, using LandGEM at 
landfills that have methane content outside the range of 40 to 60 percent is not 
recommended. The first-order decomposition rate equation used by LandGEM to determine 
emissions may not be valid outside of this range. 

The production of methane is determined using the first-order decomposition rate equation 
and is not affected by the concentration of methane. However, the concentration of methane 
affects the calculated production of carbon dioxide. The production of carbon dioxide (QCO2) 
is calculated from the production of methane (QCH4) and the methane content percentage 
(PCH4) using the equation 

Q = Q × {[1 (P 100)] − 1}CO2 CH 4 CH 4 

This equation is derived as follows: 

Qtotal = QCH 4 + QCO 2


Q = Q × (P 100)
CH 4 total CH 4 

Q = Q − Q = [Q (P 100)] − QCO2 total CH 4 CH 4 CH 4 CH 4 

QCO2 = QCH 4 × { [1 ( PCH4 100)] − 1} 

where Qtotal is the total production of landfill gas. 
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Gas/Pollutant Concentration 
(ppmv) 

Molecular
Weight Notes

Gases 
Total landfill gas Not applicable 30.03 
Methane Not applicable 16.04 
Carbon dioxide Not applicable 44.01 

4,000 for CAA 
600 for Inventory No or 

NMOCs Unknown Co-disposal 86.18 
2,400 for Inventory 

Co-disposal 
Pollutants: 
1,1,1-Trichloroethane (methyl chloroform) 0.48 133.41 A 
1,1,2,2-Tetrachloroethane 1.1 167.85 A, B 
1,1-Dichloroethane (ethylidene dichloride) 2.4 98.97 A, B 
1,1-Dichloroethene (vinylidene chloride) 0.20 96.94 A, B 
1,2-Dichloroethane (ethylene dichloride) 0.41 98.96 A, B 
1,2-Dichloropropane (propylene dichloride) 0.18 112.99 A, B 
2-Propanol (isopropyl alcohol) 50 60.11 B 
Acetone 7.0 58.08 
Acrylonitrile 6.3 53.06 A, B 

Benzene 
1.9 for No or Unknown Co-disposal 

78.11 A, B
11 for Co-disposal 

Bromodichloromethane 3.1 163.83 B 
Butane 5.0 58.12 B 
Carbon disulfide 0.58 76.13 A, B 
Carbon monoxide 140 28.01 

Section 4.

Selecting Gases/Pollutants


You can choose four gases or air pollutants to be modeled at one time. The gases and 
pollutants to choose from and data associated with them are shown in Table 4. 

Table 4. Gas/Pollutant Default Data Used in LandGEM. 
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Carbon tetrachloride 4.0×10-3 153.84 A, B 
Carbonyl sulfide 0.49 60.07 A, B 
Chlorobenzene 0.25 112.56 A, B 
Chlorodifluoromethane 1.3 86.47 
Chloroethane (ethyl chloride) 1.3 64.52 A, B 
Chloroform 0.03 119.39 A, B 
Chloromethane 1.2 50.49 B 
Dichlorobenzene 0.21 147 B, C 
Dichlorodifluoromethane 16 120.91 
Dichlorofluoromethane 2.6 102.92 B 
Dichloromethane (methylene chloride) 14 84.94 A 
Dimethyl sulfide (methyl sulfide) 7.8 62.13 B 
Ethane 890 30.07 
Ethanol 27 46.08 B 
Ethyl mercaptan (ethanethiol) 2.3 62.13 B 
Ethylbenzene 4.6 106.16 A, B 
Ethylene dibromide 1.0×10-3 187.88 A, B 
Fluorotrichloromethane 0.76 137.38 B 
Hexane 6.6 86.18 A, B 
Hydrogen sulfide 36 34.08 
Mercury (total) 2.9×10-4 200.61 A 
Methyl ethyl ketone 7.1 72.11 A, B 
Methyl isobutyl ketone 1.9 100.16 A, B 
Methyl mercaptan 2.5 48.11 B 
Pentane 3.3 72.15 B 
Perchloroethylene (tetrachloroethylene) 3.7 165.83 A 
Propane 11 44.09 B 
t-1,2-Dichloroethene 2.8 96.94 B 

Toluene 39 for No or Unknown Co-disposal 92.13 A, B170 for Co-disposal 
Trichloroethylene (trichloroethene) 2.8 131.40 A, B 
Vinyl chloride 7.3 62.50 A, B 
Xylenes 12 106.16 A, B 
A. Hazardous air pollutants (HAP) listed in Title III of the 1990 Clean Air Act Amendments. 
B. Considered volatile organic compounds (VOC), as defined by U.S. EPA in 40 CFR 51.100(s). 
C. Source tests did not indicate whether this compound was the para- or ortho- isomer. The para- isomer is a Title III-

listed HAP. 

Table 4. Gas/Pollutant Default Data Used in LandGEM (Concluded) 

Concentrations, molecular weights, and notes for NMOCs and the 46 air pollutants 
contained in Table 4 are from Tables 2.4-1 and 2.4-2 of AP-42 (November 1998 version). 
These default pollutant concentrations have already been corrected for air infiltration, as 
stated in AP-42. If you use a site-specific value for NMOC Concentration, then you must 
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correct for air infiltration. 

As discussed in Section 3.3, the NMOC Concentration for the inventory default is 600 ppmv 
where co-disposal of hazardous waste has either not occurred or is unknown and 2,400 
ppmv where co-disposal of hazardous waste has occurred. Similarly, benzene and toluene 
have different concentrations depending upon the co-disposal status of the landfill. Both no 
or unknown co-disposal and co-disposal concentrations are shown in Table 4 for these 
pollutants. 

The molecular weight of landfill gas was estimated using a weighted average of the 
molecular weights for methane and carbon dioxide. The molecular weight of 30.03 
represents landfill gas as 50 percent methane and 50 percent carbon dioxide. If the Methane 
Content model parameter is changed to a value other than 50 percent, then the molecular 
weight of total landfill gas is adjusted to represent the appropriate methane content. 

Image 4 shows where you can select four gases or pollutants on the USER INPUTS 
worksheet. Each of the gas or pollutant entries can be selected from the drop-down menus. 

Image 4. Gas/Pollutant Inputs. 
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The Edit Existing or Add New Pollutant Parameters button in the USER INPUTS worksheet 
allows you to change the default pollutant parameters, including concentrations and 
molecular weights, for any of the 46 air pollutants listed on the drop-down menus, as well as 
add new pollutants and corresponding parameters. Clicking on the Edit Existing or Add New 
Pollutant Parameters button lets you view and edit the default parameters for existing 
pollutants in the POLLUTANTS worksheet. The default parameters shown on the 
POLLUTANTS worksheet are identical to the ones in Table 4. In addition, there are entry 
boxes at the bottom of the POLLUTANTS worksheet where you can enter new pollutants 
and corresponding concentrations and molecular weights. The Enter New Pollutant 
Parameters and Edit Existing Pollutant Parameters buttons at the top of the POLLUTANTS 
worksheet help guide you through this worksheet. 

The model does not allow you to edit default parameters for total landfill gas, methane, 
carbon dioxide, or NMOCs, nor does it allow you to change names of existing pollutants. To 
restore the default pollutant parameters for existing pollutants and remove any new 
pollutants you may have added, click on the Restore Default Pollutant Parameters button in 
the USER INPUTS worksheet. Clicking this button also returns the gas/pollutant drop-down 
menus in the USER INPUTS worksheet to their default selections. 

In the Description/Comments entry box, you can enter detailed information about the 
landfill or the scenario you are modeling. The Description/Comments entry box is limited to 
450 characters. 

To clear all of the gas/pollutant selections (but not the pollutant parameters) and the landfill 
characteristics and waste acceptance rate inputs (see Section 5.0), click on Clear ALL Non-
Parameter Inputs/Selections in the USER INPUTS worksheet. The gas/pollutant drop-down 
menus will return to their default selections, as shown in Image 4. The 
Description/Comments box is not affected by the Clear ALL Non-Parameter 
Inputs/Selections button. 
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Section 5.

Entering Waste Acceptance Data


Waste Acceptance Rates must be entered in the USER INPUTS worksheet for LandGEM to 
properly estimate emissions. Enter annual acceptance rates for each year listed in the Waste 
Acceptance Rates table from the Landfill Open Year to the current year or the Landfill 
Closure Year. The Waste Acceptance Rates table is shown in Image 5. Once you enter the 
Landfill Open Year, the year column of the Waste Acceptance Rates table automatically 
shows the years for which acceptance rate data are needed. 

Image 5. Waste Acceptance Rate Inputs. 

You may enter Waste Acceptance Rates in metric units of megagrams per year or English 
units of short tons per year by selecting from the drop-down menu. The default unit of 
measure for Waste Acceptance Rates is megagrams per year. If you enter acceptance rates in 
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If you... Then LandGEM will... 

Enter acceptance rates beyond the Ignore the acceptance rates you entered past the 
Landfill Closure Year you entered, Landfill Closure Year. 

Enter acceptance rates through the Apply the final (or most recent) acceptance rate 
current year but not up to the Landfill you entered to the years between the current 
Closure Year you entered, year and the Landfill Closure Year. 

Enter acceptance rates through the Apply the final (or most recent) acceptance rate 
current year and choose to have the you entered to each successive year not having 
model calculate closure year, an acceptance rate until the waste design 

capacity is reached.  A smaller acceptance rate 
may be used the last year to achieve the exact 
design capacity.  The final year the landfill 
receives waste becomes the closure year. 

units of megagrams per year, then LandGEM automatically calculates and displays the 
acceptance rates in units of short tons per year. Likewise, if you enter acceptance rates in 
short tons per year, then LandGEM automatically calculates and displays acceptance rates in 
megagrams per year. 

The model makes the assumptions outlined in Table 5. regarding data entered in the Waste 
Acceptance Rates table. 

Table 5. Acceptance Rate Input Options. 

The model limits the number of years for entering Waste Acceptance Rates to 80 years. See 
Section 2.6 for instructions on estimating total emissions properly for scenarios where 
landfills accept waste beyond the waste acceptance limit of 80 years. 

Landfill gas emission factors were developed using empirical data from U.S. MSW landfills. 
The composition of waste in the landfills reflects U.S. waste composition including MSW, 
inert material, and other non-hazardous waste streams. For a landfill that may have a portion 
containing non-biodegradable waste (i.e., inert material), such as ash from waste 
combustion, this portion may be subtracted from the Waste Acceptance Rates depending on 
documentation and approval from a regulatory authority. However, this is not recommended 
for sites that are typical of MSW landfills containing a range of waste that may or may not 
be degradable. This is because the emission factors were developed relating total waste 
quantity to total quantity of landfill gas. 
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To clear all entries in the Waste Acceptance Rates table, in addition to landfill 
characteristics inputs and gas/pollutant selections, click on Clear ALL Non-Parameter 
Inputs/Selections in the USER INPUTS worksheet. The Waste Acceptance Rates table then 
returns to its defaults, as shown in Image 5. 
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Section 6.

Printing Inputs


To review your inputs as they will be used by LandGEM, go to the INPUT REVIEW 
worksheet. All data entered in the USER INPUTS worksheet as well as inputs determined 
by the model, such as calculated landfill closure year and waste acceptance rates as they are 
interpreted by LandGEM, appear on the INPUT REVIEW worksheet. Image 6 shows a 
scenario where closure year is unknown. 

Image 6. INPUT REVIEW Worksheet. 

To print the INPUT REVIEW worksheet, select Print... from the File menu. The INPUT 
REVIEW worksheet is set to print on one page. However, you may adjust this, as well as 
other print settings, by selecting Page Setup... from the File menu. 
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Section 7.

Viewing and Printing Tabular Results


To view emission estimates in a tabular format, go to the RESULTS worksheet. When 
comparing results from LandGEM with measurements of extracted gas collected at a site, 
the landfill owner or operator must adjust for air infiltration prior to any comparisons. Image 
7 displays the RESULTS worksheet for the scenario shown in Image 6. 

Image 7. RESULTS Worksheet. 

Data on the RESULTS worksheet include 
• Landfill closure year (provided on USER INPUTS worksheet or calculated), 
• Methane content from USER INPUTS worksheet, 
• Years of waste acceptance from open year to closure year of the landfill, 
• Annual waste acceptance rates used by the model in megagrams per year and short 
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tons per year, 
•	 Annual waste-in-place amounts based on acceptance rates used by the model, in 

megagrams and short tons, 
•	 Annual emission estimates for the four gases/pollutants selected on the USER 

INPUTS worksheet in megagrams per year, cubic meters per year, and a third 
measurement unit that you may select from the drop-down menu. The third unit of 
measure options are average cubic feet per minute, cubic feet per year, and short tons 
per year. LandGEM uses average cubic feet per minute as the default third unit. 

To print the RESULTS worksheet, select Print... from the File menu. The RESULTS 
worksheet is set to print on one page. However, you may adjust this as well as other print 
settings by selecting Page Setup... from the File menu. 

Formatting of the values contained in the RESULTS worksheet is protected from user 
modification. To adjust the number formats of the values contained in the RESULTS 
worksheet, you will need to copy and paste the emission estimates into a new Microsoft 
Excel file by following the instructions below: 

1.	 Highlight cells A7 to Q149 and select Copy from the Edit menu, 
2.	 Open a new Microsoft Excel file by selecting New... (Blank Workbook) from the File 

menu, 
3.	 Select Paste Special... from the Edit menu and click on the Values radio button in the 

Paste Special window that appears. 
4.	 You can now change the number formats of these emission values by selecting 

Cells...Number from the Format menu. 

It is important to note that when the Methane Content is assumed to be 50 percent by 
volume (default), then methane and carbon dioxide emission rates are identical on a volume 
basis (e.g., cubic meters per year, average cubic feet per minute, cubic feet per year) because 
carbon dioxide is also assumed to be 50 percent by volume. However, methane and carbon 
dioxide emission rates will differ from one another on a mass basis (e.g., megagrams per 
year, short tons per year) because methane and carbon dioxide have different molecular 
weights and, thus, different mass emissions. 
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Section 8.

Viewing and Printing Graphical Results


To view the emission estimates in a graphical format, go to the GRAPHS worksheet. Image 
8 contains one of the three graphs generated on the GRAPHS worksheet for the scenario 
shown in Image 6. 

Image 8. Graphical Results in Units of Megagrams per Year. 

A total of three graphs are generated for each scenario, one for each unit of measure of 
emissions on the RESULTS worksheet. The top two graphs are in units of megagrams per 
year and cubic meters per year, respectively. The third graph represents the units you 
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selected on the RESULTS worksheet (see Section 7.0 for further discussion), which defaults 
to average cubic feet per minute. The emission estimates for all four gases or pollutants are 
shown on each of the three graphs using a different color to represent each gas or pollutant’s 
emissions. 

To print the GRAPHS worksheet, select Print... from the File menu. The GRAPHS 
worksheet is set to print on one page. However, you may adjust this as well as other print 
settings by selecting Page Setup... from the File menu. 

Editing and formatting of the graphs are protected from user modification. To create graphs 
that can be edited or formatted, you will need to copy and paste the emission estimates from 
the RESULTS worksheet or the INVENTORY worksheet into a new Microsoft Excel file by 
following the instructions below. 

1.	 Highlight the cells containing the values to be graphed and select Copy from the Edit 
menu. 

2.	 Open a new Microsoft Excel file by selecting New... (Blank Workbook) from the File 
menu. 

3.	 Select Paste Special... from the Edit menu and click on the Values radio button in the 
Paste Special window that appears. 

4.	 You can now create graphs from these emission values by selecting Chart... from the 
Insert menu and following the instructions in the Chart Wizard window. 
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Section 9.

Viewing and Printing Inventory Results


To view emission estimates for use in emission inventories and air permits, go to the 
INVENTORY worksheet. This worksheet allows you to view and print emission estimates 
for a particular year for all gases or pollutants in megagrams per year, cubic meters per year, 
average cubic feet per minute, cubic feet per year, and short tons per year. You must enter a 
valid four-digit year in the designated entry box to obtain estimates for a particular year. The 
inventory year entered must be between the year after the Landfill Open Year entered and 
140 years past the Landfill Open Year. Image 9 displays the INVENTORY worksheet for 
the scenario shown in Image 6. 

Image 9. INVENTORY Worksheet. 
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To print the INVENTORY worksheet, select Print... from the File menu. The INVENTORY 
worksheet is set to print on one page. However, you may adjust this as well as other print 
settings by selecting Page Setup... from the File menu. 

Formatting of the values contained in the INVENTORY worksheet is protected from user 
modification. To adjust the number formats of the values contained in the INVENTORY 
worksheet, you will need to copy and paste the emission estimates into a new Microsoft 
Excel file by following the instructions below: 

1.	 Highlight cells B5 to K68 and select Copy from the Edit menu. 
2.	 Open a new Microsoft Excel file by selecting New... (Blank Workbook) from the File 

menu. 
3.	 Select Paste Special... from the Edit menu and click on the Values radio button in the 

Paste Special window that appears. 
4.	 You can now change the number formats of these emission values by selecting 

Cells...Number from the Format menu. 
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Section 10.

Viewing and Printing the Summary Report


To view the summary report, go to the REPORT worksheet. Information contained in the 
summary report on the RESULTS worksheet includes 

•	 A cover page showing the LandGEM title screen (pop-up introduction window that 
includes the model version and date), Landfill Name or Identifier and 
Description/Comments entered in the USER INPUTS worksheet, the current date, 
the first-order decomposition rate equation used to estimate emissions, and a general 
description of the model, 

•	 Data contained in the INPUT REVIEW worksheet, including landfill characteristics, 
model parameters, gases/pollutants selected, waste acceptance rates, and yearly 
waste-in-place amounts, 

•	 Emission estimates in graphical format, as shown on the GRAPHS worksheet, and 
•	 Emission estimates in tabular format, from the RESULTS worksheet. 

To print the REPORT worksheet, select Print... from the File menu. The REPORT 
worksheet is set to print on seven pages. However, you may adjust this as well as other print 
settings by selecting Page Setup... from the File menu. 
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Section 11.

Additional Information and References


Additional Information 
For further information regarding landfill gas emissions, please access the following Web 
sites and documents: 

•	 Rules and Implementation Information for Standards of Performance for MSW 
Landfills. EPA, Technology Transfer Network, Air Toxics Website: 
http://www.epa.gov/ttnatw01/landfill/landflpg.html. 
The following topics are included on this Web site: 
- Proposed and Promulgated Rules, including the NSPS/EG requirements, 
- Closely Related Rules, Policies or Program Guidance, 
- Technical Information, including Background Information Document 
(BID)/Response to Comments, Fact Sheets, and Risk Assessment, 
- Implementation and Enabling Documents, 
- Emission Estimation Tools, including the LandGEM software, 
- Source Identification and Location, 
- Outreach and Training Materials, 
- Permitting, 
- Compliance and Enforcement. 

•	 NESHAP Rule and Implementation Information for Municipal Solid Waste Landfills. 
EPA, Technology Transfer Network, Air Toxics Website: 
http://www.epa.gov/ttnatw01/landfill/lndfillpg.html. 
The following topics are included on this Web site: 
- Proposed and Promulgated Rules, including the NESHAP requirements, 
- Closely Related Rules, Policies or Program Guidance, 
- Technical Information, including Background Information Document 
(BID)/Response to Comments, Fact Sheets, and Economic Analysis, 
- Implementation Documents, 
- Source Identification and Location, 
- Outreach and Training Materials, 
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- Permitting, 
- Compliance and Enforcement. 

•	 Compilation of Air Pollutant Emission Factors (AP-42), Volume 1: Stationary Point 
and Area Sources, 5th ed., Chapter 2.4: Municipal Solid Waste Landfills. EPA, 
Office of Air Quality Planning and Standards. Research Triangle Park, NC. 
http://www.epa.gov/ttn/chief/ap42/ch02/final/c02s04.pdf. 

•	 Use of Landfill Gas Generation Model to Estimate VOC Emissions from Landfills. 
Memorandum from Y.C. McGuinn, Radian Corporation, to Susan Thorneloe, EPA. 
June 21, 1988. Public Docket No. A-88-09. 

•	 Sensitivity Analysis of Landfill Gas Generation Model. Memorandum from Y.C. 
McGuinn, Radian Corporation, to Susan Thorneloe, EPA. June 21, 1988. Public 
Docket No. A-88-09. 

•	 Methodology Used to Revise the Model Inputs in the Municipal Solid Waste 
Landfills Input Database (Revised). Memorandum from W.R. Pelt, Radian 
Corporation, to Municipal Solid Waste Landfills Docket A-88-09. April 28, 1993. 
Public Docket No. A-88-09. 

•	 Methane Emissions from Landfills and Open Dumps, In EPA Report to Congress on 
International Anthropogenic Methane Emissions: Estimates for 1990. S.A. 
Thorneloe, M. Doorn, and M. Barlaz. EP A, Office of Policy, Planning and 
Evaluation. Washington, DC, 1994. EPA-230-R-93-010. 

•	 Landfill Gas Utilization – Options, Benefits, and Barriers, The Second United States 
Conference on Municipal Solid Waste Management, Arlington, VA. S.A. Thorneloe. 
Published in Conference Proceedings, June 3S5, 1992. 

•	 Global Methane Emissions from Waste Management. S.A. Thorneloe, M. A. Barlaz, 
R. Peer, L. C. Huff, L. Davis, and J. Mangino. Published in Atmospheric Methane: 
Sources, Sinks, and Role in Global Change, NATO ASI Series, Vol. 13, 1993. 
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Introduction 
The Landfill Gas Emissions Model (LandGEM) provides an automated estimation tool 
for quantifying air emissions from municipal solid waste (MSW) landfills. The model was 
developed by the Control Technology Center (CTC) of the U.S. Environmental Protection 
Agency and can be obtained by downloading from the TTNWeb 
(http://www.epa.gov/ttn/catc/products.html#software). It is also available from the National 
Technical Information Service (NTIS). 

Air emissions from landfills come from landfill gas generated by the decomposition of waste 
in the landfill. Landfill gas is assumed by this model to be roughly half methane and half 
carbon dioxide with additional, relatively low, concentrations of other air pollutants. The 
following information is needed to estimate emissions from a landfill (see the Glossary of 
Terms at the end of Appendix A): 

•	 The waste design capacity of the landfill, 
•	 The amount of waste-in-place in the landfill or the annual waste acceptance rate for 

the landfill, 
•	 The methane generation rate (k), 
•	 The potential methane generation capacity (Lo), 
•	 The concentration of total nonmethane organic compounds (NMOCs) and speciated 

NMOCs found in the landfill gas, 
•	 The years the landfill has been in operation, and 
•	 Whether the landfill has been used for disposal of hazardous waste (co-disposal). 

The estimation method used by the model is a simple first-order decay equation. Because 
the data available for landfills (such as data on the quantity, age, and composition of the 
waste in the landfill) are limited, using a more sophisticated calculation method is not 
justified. The Landfill Gas Emissions Model estimates emissions of total landfill gas, 
methane, carbon dioxide (CO2), NMOCs, and selected air pollutants. Information on the 
assumptions used in the model can be found in the background information document (EPA, 
1991a) written to support the Standards of Performance for New Stationary Sources 
(NARA, 1997a) and Emission Guidelines for Control of Existing Sources (NARA, 1997b) 
and in the public docket (McGuinn, 1988a; McGuinn, 1988b; Pelt, 1993). 

The Landfill Gas Emissions Model can be used with site-specific data for all the information 
needed to generate emission estimates, or it can be used with two different sets of default 
values. One set of default values (the CAA defaults) is for estimating emissions to determine 
the applicability of the Clean Air Act (CAA) regulations for MSW landfill emissions, 
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specifically the New Source Performance Standards (NSPS) for new MSW Landfills and the 
emission guidelines (EG) for existing MSW landfills. The NSPS/EG were initially proposed 
May 30, 1991 (EPA, 1991b), and the final rule was promulgated on March 12, 1996 
(EPA, 1996). 

The applicability of the NSPS/EG to a particular landfill can be determined based on 
emissions estimated using the CAA defaults in the model. The applicability of the NSPS/EG 
to a particular landfill is determined in tiers. There is, first, a size cutoff (i.e., 2.5 million 
tons or 2.5 million cubic meters of waste) below which landfills are not subject to the rule. 
After the size cutoff, the first tier of the applicability determination is to assess whether 
emissions of NMOCs exceed a cutoff value of 50 Mg of NMOCs/yr using LandGEM with 
all default values set for the CAA defaults. Landfills with emissions exceeding the cutoff 
value can choose to install emission controls or move to the second tier of the applicability 
determination, which is to test the landfill for landfill gas NMOC concentrations. If the 
revised NMOC concentrations result in NMOC emissions that still exceed the cutoff value, 
the landfill can choose to install emission controls or move to the third tier of the 
applicability determination, which is to perform another test to obtain a site-specific k value 
(the methane generation rate constant). 

The CAA default values in the model provide emission estimates that would reflect the 
expected maximum emissions and generally would be used only for determining the 
applicability of the regulations to a landfill. To estimate actual emissions in the absence of 
site-specific data, a second set of default values (the inventory defaults) is provided in the 
model. The inventory default values in the model are based on emission factors from the 
U.S. Environmental Protection Agency’s Compilation of Air Pollutant Emission Factors, 
AP-42 (EPA, 1998). The inventory default values provide emission estimates that should 
reflect typical landfill emissions and are the values suggested for use in developing 
estimates for state inventories. 

The EPA fully recognizes that modeling landfill air emissions accurately is difficult due to 
limitations in available information for inputs to the model. However, as new landfills are 
constructed and operated and better information is collected, the present modeling approach 
can be improved. As better data become available, including longer term data on landfill air 
emissions, better modeling approaches are expected to evolve. For example, several firms in 
the landfill gas industry have models for estimating landfill emissions that are regarded as 
proprietary. If this information is released to the public, the EPA can use it to improve the 
present emission estimation approach. In addition, as data become available through the 
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implementation of the NSPS/EG, the new data can be used to improve the modeling 
calculations. 

Landfill Emissions 
The Landfill Gas Emissions Model estimates the emissions resulting from the 
biodegradation of waste in landfills. The anaerobic decomposition of waste in MSW 
landfills causes emissions of landfill gas. As landfill gas passes through the waste, it sweeps 
NMOCs and other air pollutants present in the waste to the surface. The composition of 
MSW landfill emissions is estimated by the model to be about 50 percent methane (CH4) 
and 50 percent carbon dioxide (CO2), with additional, trace constituents of NMOCs, 
although, these default percentages can easily be changed. The concentration of total and 
speciated NMOCs can be estimated by the model using either default or site-specific 
concentrations. The pollutant regulated under the NSPS/EG is MSW landfill emissions, but 
the surrogate for measuring MSW landfill emissions for the applicability of and compliance 
with the regulations is NMOCs. 

The EPA has determined that emissions from MSW landfills cause, or contribute 
significantly to, air pollution that may reasonably be anticipated to endanger public health or 
welfare. Some NMOCs are known or suspected carcinogens, or cause other noncancer 
health effects. Public welfare concerns include the odor nuisance from the landfill gas and 
the potential for CH4 migration, both on-site and off-site, which may lead to explosions or 
fires. The CH4 emitted from landfills is also a concern because it is a greenhouse gas and 
contributes to global climate change. It has been estimated that the United States contributed 
8 to 16 Tg/yr of CH4 to the atmosphere in 1990, about 40 percent of the worldwide amount 
emitted from landfills and open dumps (Thorneloe and Pacey, 1994; Thorneloe et al., 1994). 
The environmental and welfare concerns associated with MSW landfill air emissions are 
documented in the preamble to the proposed NSPS/EG (EPA, 1991c). 

This computer model uses a first-order decomposition rate equation and estimates annual 
emissions over any time period specified by the user. Total landfill gas emissions are 
estimated by estimating CH4 generation and doubling it (the landfill gas is assumed to be 
half CH4 and half CO2). Methane generation is estimated using Lo, the potential CH4 

generation capacity of the waste, and k, the CH4 generation rate constant, which accounts for 
how quickly the CH4 generation rate decreases once it reaches its peak rate. The CH4 

generation rate is assumed to be at its peak upon closure of the landfill or final placement of 
waste at the site. The model allows the user to enter Lo and k values derived using site-
specific test data collected at the landfill (site-specific data may be collected using the test 
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methods specified in the NSPS/EG for MSW landfills), or to use the CAA or inventory 
default values. 

The model estimates emission rates for total landfill gas, CH4, CO2, NMOCs, and a list of air 
pollutants expected to be emitted from landfills based on test data from AP-42 (EPA, 1998). 

Methane and Carbon Dioxide 
The NSPS/EG require only NMOC emission estimates, but the model provides estimates of 
all landfill gas constituents. Landfill gas is assumed to be half CH4 and half CO2. The model 
assumes that CO2 emissions are the same as CH4 emissions and that landfill gas emissions 
are twice the CH4 emissions. The generation of CH4 from a landfill is a function of k, the 
CH4 generation rate constant, and Lo, the CH4 generation potential. 

The CH4 generation rate constant, k, determines the rate of CH4 generation for each submass 
of waste in the landfill. The higher the value of k, the faster the CH4 generation rate 
increases and then decays over time. The value of k is a function of (1) waste moisture 
content, (2) availability of the nutrients for methanogens, (3) pH, and (4) temperature. The k 
values obtained from the data collected for the NSPS/EG range from 0.003 to 0.21 (EPA, 
1991a). These values were obtained from theoretical models using field test data and from 
actual field test measurements. If no user-specified k value is entered into LandGEM, a 
default value is used. The default k value used by the model is 0.05 year-1 for the CAA 
conventional landfills option (EPA, 1991a). 

The value for the potential CH4 generation capacity of waste (Lo) depends only on the type 
of waste in the landfill. The higher the cellulose content of the waste, the higher the value of 
Lo. The values of theoretical and obtainable Lo range from 6.2 to 270 m3/Mg of waste (EPA, 
1991c). If no user-specified Lo value is entered into LandGEM, a default value is used for 
Lo. The default Lo value used in the model is 170 m3/Mg of waste for the CAA conventional 
landfills option (EPA, 1991a). 

Air Pollutants 
Landfill gas contains low concentrations of air pollutants from the leaching and 
decomposition of waste. The Landfill Gas Emissions Model can estimate emissions of such 
air pollutants if users choose to do so. Emissions of air pollutants are based on 
concentrations of air pollutants in the landfill gas. The model contains default concentrations 
for specific air pollutant compounds. The list of air pollutants expected to be emitted with 
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landfill gas and the concentrations of these air pollutants were taken from test data in AP-42 
(EPA, 1998). The default air pollutants included in the model are designated as a hazardous 
air pollutant (HAP) or a volatile organic compound (VOC) with the HAP or VOC 
abbreviation after their chemical names. These designations are based on EPA HAP and 
VOC definitions that are current as of April 2004. 

Because some air pollutant concentrations in the landfill gas are slightly higher for landfills 
that have been used for disposal of hazardous waste than for those that have not, there is a 
choice in the model between “Co-disposal,” (i.e., landfills used for disposal of hazardous 
and non-hazardous waste), and “No or Unknown Co-disposal,” (i.e., landfills that have not 
been used for disposal of hazardous waste or unknown disposal of hazardous waste). For 
example, concentrations in the model for benzene and toluene are different for landfills with 
hazardous waste “Co-disposal” than for landfills with “No or Unknown Codisposal.” 

Landfill sites that have hazardous waste co-disposal or Superfund sites should use the co­
disposal option for estimating air pollutant emissions. In general, it is recommended that 
landfill owners and operators obtain actual test data for air pollutant concentrations in the 
landfill gas for their specific landfill. 

Nonmethane Organic Compounds 
The NMOC concentration in the landfill gas is a function of the types of waste in the landfill 
and the extent of the reactions that produce various compounds from the anaerobic 
decomposition of waste. To determine NMOC concentrations, NMOC data were collected 
from emission test reports from industry, state, and local regulatory agencies (Pelt, 1993). 
The NMOC concentrations from 23 landfills ranged from 240 to 14,300 ppmv. Three 
suggested default NMOC concentrations are used in the model: one for the CAA default 
option and two for the inventory default option (one for co-disposal and one for no or 
unknown co-disposal). For the CAA default option, the NMOC concentration as hexane is 
4,000 ppmv. For the inventory default option, the NMOC concentration as hexane for 
co-disposal is 2,400 ppmv and is 600 ppmv for no or unknown co-disposal. The analysis of 
NMOC concentrations in landfill gas is documented in a memorandum (Pelt, 1993), which 
can be found in Public Docket No. A-88-09 and in AP-42 (EPA, 1998). Because the NMOC 
concentration in landfill gas varies from landfill to landfill, collection of site-specific data 
using EPA Method 25C will provide the most accurate estimates (EPA, 1991c). 
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GLOSSARY OF TERMS


Term Definition 

Co-disposal Disposal of hazardous waste as well as other 
kinds of waste in a landfill. 

Waste Design Capacity The total amount of waste that can be 
disposed of in the landfill. 

Landfill Gas Landfill gas is a product of biodegradation of 
waste in landfills and consists of primarily 
CH4 and CO2, with trace amounts of NMOCs 
and air pollutants. 

Methane Generation Rate (k) k is a constant that determines the rate of 
landfill gas generation. The first-order 
decomposition rate assumes that k values 
before and after peak landfill gas generation 
are the same. k is a function of moisture 
content in the landfill waste, availability of 
nutrients for methanogens, pH, and 
temperature. 

Nonmethane Organic Compounds 
(NMOCs) 

NMOCs are specified in this program as the 
fraction of landfill gas containing 
nonmethane organic compounds, expressed 
as hexane. NMOCs include air pollutants and 
VOCs. NMOC concentration can be 
measured using guidance provided by EPA 
Method 25C. 

Potential Methane Generation Capacity 
(Lo) 

Lo is a constant that represents the potential 
capacity of a landfill to generate CH4 (a 
primary constituent of landfill gas). Lo 
depends on the amount of cellulose in the 
waste. 

Air Pollutants Compounds found in landfill gas or emitted 
with landfill gas, some of which are listed as 
air pollutants under section 112 of the Clean 
Air Act (CAA). A total of 46 air pollutants 
emitted from landfills are included in the 
model. 

Landfill Closure Year The year in which the landfill ceases, or is 
expected to cease, accepting waste. 
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